PCSA
VAXmate Standalone Release Notes,
Version 2.1

Order Number AA-LB68B-TH

October 1988

Revision/Update Information: This information supercedes Version 2.0, order number AA-LB68A-TH.

Operating System and Version: VMS Versions 4.7, 5.0, or later
DOS, Versions 3.2, 3.3, or later
MS-DOS, Versions 3.2 and 3.3

Software Version: DECnet/PCSA Client, Version 2.1
VAXmate Services for MS-DOS, Version 2.1
VAX/VMS Services for MS-DOS, Version 2.1
VAXmate Standalone, Version 2.1

digital equipment corporation
maynard, massachusetts
## Contents

1 DECnet/PCSIna V2.1 Standalone Release Notes

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>MS-DOS</td>
<td>1</td>
</tr>
<tr>
<td>New Modules</td>
<td>1</td>
</tr>
<tr>
<td>Connecting an LA50 Printer to a PC Workstation</td>
<td>2</td>
</tr>
<tr>
<td>DRIVPARM</td>
<td>2</td>
</tr>
<tr>
<td>Minimum Value for SHELL /E</td>
<td>2</td>
</tr>
<tr>
<td>FC /C</td>
<td>2</td>
</tr>
<tr>
<td>KEYERD and PS/2 Workstations</td>
<td>2</td>
</tr>
<tr>
<td>VT220 Terminal Emulator</td>
<td>2</td>
</tr>
<tr>
<td>Closing the Command Window</td>
<td>2</td>
</tr>
<tr>
<td>Cut and Paste to an EDT Session</td>
<td>3</td>
</tr>
<tr>
<td>UDKs</td>
<td>3</td>
</tr>
<tr>
<td>Full Modem Control</td>
<td>4</td>
</tr>
<tr>
<td>MS-Windows</td>
<td>4</td>
</tr>
<tr>
<td>Data Exchange</td>
<td>4</td>
</tr>
<tr>
<td>Script/Dialog Clipboard Problem</td>
<td>4</td>
</tr>
<tr>
<td>Screen Exchange Error</td>
<td>5</td>
</tr>
<tr>
<td>Desktop Applications</td>
<td>5</td>
</tr>
<tr>
<td>Changing Time in CALENDAR.EXE</td>
<td>5</td>
</tr>
<tr>
<td>CALENDAR.EXE and 24-Hour Time</td>
<td>5</td>
</tr>
<tr>
<td>Deleting a Current File When Running Calendar and Cardfile</td>
<td>5</td>
</tr>
<tr>
<td>Lowercase AM and PM in CONTROL.EXE</td>
<td>5</td>
</tr>
<tr>
<td>Modal Dialog Boxes</td>
<td>5</td>
</tr>
<tr>
<td>Text and Graphics Alignment Problem</td>
<td>6</td>
</tr>
<tr>
<td>Notepad Save Error</td>
<td>6</td>
</tr>
<tr>
<td>Notepad and CR,LF,CR</td>
<td>6</td>
</tr>
</tbody>
</table>
Display ............................................ 6
    MCGA Monitors and Umlauts .......................... 6
    No Support of Newest ISO Font Set .................... 6
    Cursor Type ......................................... 6
    Mouseless Version of MS-Windows Displays Mouse Cursor . 7
    SUBST of Drive B ..................................... 7
    Size and Scale Problems ................................ 7
    Bad Font Character .................................... 7
    Working with Standard Applications .................... 8
    Batch File and Program Information Files ............. 8
File and Disk .......................................... 8
    Protected Files ...................................... 8
    Notepad and File Handling .............................. 8
    SUBST and Phantom Drives ............................. 9
    Formatting a Data Disk ................................. 10
    Updating Directories in Multiple Windows .............. 10
    Renaming a File ...................................... 10
    MS-DOS Executive Window Make System Disk Command .... 10
    File Name Limitations ................................ 10
    COMMAND.COM and Class C+ Applications ................ 11
    Copying Files ......................................... 11
    Drive Letter Fails in COMMAND.COM .................... 11
Keyboard .................................................. 11
    Illogical Keyboard Messages ............................ 11
MS-Paint ................................................ 12
    Memory Requirements .................................... 12
    Printing an MS-Paint Screen ............................ 12
    Dotted Line Selection ................................ 13
MS-Write ................................................ 13
    Printing Text and Graphics ............................ 13
    Invalid Font List ..................................... 13
    Incorrect Fonts ....................................... 13
    MS-Write and Text-Only Files .......................... 13
PIF Files ................................................ 14
    PIF File and RUN MODULE Must Have Same Name .......... 14
Contents

Printing ........................................... 14
  Printing a Text File from the MS-DOS Executive Window ... 14
  Printing From a Class A Application Using GDI ........... 14
  Printer Fonts with Pagemaker and MS-Write ............... 15
  LA50 Printer and Compressed Mode ....................... 15
  Printing MS-Windows Screens ......................... 15
  LA210 Printer and MS-Paint .......................... 15
  Text-Only Printer Driver ............................. 15
  LINE.DRV and Paper Width and Length .................. 15
  LN03 Plus Printer Driver ............................. 15
Running Special Applications ............................. 16
  Using MS-DOS Commands and Programs .................... 16
  CreateCompatibleDC(hDC) ............................... 17
Setup Utility .......................................... 18
Other .................................................... 18
  Starting SLAPJR with the Run Command .................. 18
  Starting MS-Windows and the DIGITAL Logo ............. 18
  Interrupt 10H Function 19 Subfunctions Disabled ....... 18
  The COPY command and Device Names .................... 18
  Repeating Key Allowed to Change Focus .................. 18
  PIF Program Parameters Incompatible with DOS ........... 19
  Incompatible C Libraries .............................. 19
  Multiple Class B or C Applications Stop MS-Windows .... 20
  Testing Keyclick Volume ................................ 20
  Invalid Compose Sequences ................................ 20
  CloseComm Returns Error Message ....................... 20
  EPSONMX.DRV and Linefeed Character .................... 20
  Renaming VAXmate Server Volume Name ..................... 20
  Cancel MS-Windows Using Ctrl/C ......................... 20
  Drive Icons Not Connected ............................. 21
  File Viewing .......................................... 21
  SYS Command .......................................... 21
DECnet/PCS A V2.1 Standalone Release Notes

This document contains the release notes for DECnet/PCS A Version 2.1 Standalone Client software. The release notes cover MS-DOS, the VT220 terminal emulator, and MS-Windows.

MS-DOS

New Modules

The following modules are new:

- The XONXOFF (XONXOFF.EXE/XONXOFF.PIF) utility, which fixes the following:
  - Using VT220/SETHOST to set retries on the serial port and finding that retries were also set on the communications port.
  - Using VT220/SETHOST to set retries on the communications port and finding that nothing happened.

  The two preceding problems are fixed by running the XONXOFF command before you use VT220/SETHOST to set retries on the serial port or on the communications port.

- BACKLIST.EXE/B ACKLIST.PIF displays a listing of the files that were backed up using the native DOS V3.30 BACKUP command.

The BACKUP command now generates only two files on the destination, BACKUP.XXX and CONTROL.XXX. These files are highly efficient in storing the BACKUP information.
Connecting an LA50 Printer to a PC Workstation

If you are connecting an LA50 to an IBM PC/XT/AT or some other workstation, you must use the XON/XOFF protocol. If you use the READY/BUSY protocol, the printer is likely to timeout. Using the XON/XOFF protocol requires you to switch the printer into XON/XOFF mode (see your LA50 printing guide). After switching the printer into this mode you must run the XONXOFF program.

DRIVPARM=

DRIVPARM= is recognized in the CONFIG.SYS file.

Minimum Value for SHELL /E

The minimum value for the /E qualifier in the SHELL command for a CONFIG.SYS files has changed from 526 to 512.

FC /C

The /C qualifier for the FC command now works on international files.

KEYBRD and PS/2 Workstations

The KEYBRD command will no longer hang a PS/2 workstation.

VT220 Terminal Emulator

Closing the Command Window

When the SYSTEM: command is used in a script, a window is created that runs the COMMAND.COM application, which in turn executes the DOS command and then terminates. The COMMAND window is not closed upon exiting and script processing is suspended until the window is closed.

There are two ways to close the window:

- You can close the COMMAND window manually using its system menu.
- You can use the PIFEDIT MS-Windows application to create a .PIF file that closes COMMAND upon exiting.
If you use this option, the COMMAND.PIF file should have the following parameters:

Program Name: COMMAND.COM
Memory Requirements: 32 required
32 desired
Program Switch: Text
Screen Exchange: Text
Close Window on exit: Yes

In addition to creating the COMMAND.PIF, you must delete the following line, located under the [pif] heading, in the user's WIN.INI file:

COMMAND.COM=32

NOTE
Due to the increased size of MS-Windows, there may not be enough memory to spawn the system command.

There must be 150 Kbytes of free memory to invoke the SYSTEM: command from a script. To determine the amount of free memory, select the ABOUT option in the MS-DOS Executive System menu box.

Cut and Paste to an EDT Session

When pasting a large buffer to an EDT editing session, characters may sometimes get lost. EDT is unable to receive and process the rapid firing of characters while simultaneously updating the screen.

To avoid this loss of characters, use the following VMS command:

$ SET TERM/HOSTSYNC

If characters are still being lost, either reduce the baud rate or place EDT in line mode rather than command mode before pasting.

UDKs

Keys F6-F20 can be defined through the 7-bit and 8-bit device control string (DECUDK). The key definition will be acknowledged in both the shifted and unshifted state, depending upon the Set-Up selection.

In addition, keys F6-F20 can also be defined by the VMS DCL command DEFINE/KEY. However, the key state is the inverse of the UDK SHIFT selection in Set-Up.
From whatever state the DECUDK-defined keys are invoked, the VMS command-defined keys are invoked from the inverse state.

There are 256 bytes available to program the 15 programmable function keys. Space is supplied on a first-come/first-serve basis. After the 256 bytes are used, you cannot define additional keys or redefine existing keys until the entire buffer is cleared. Keys are loaded sequentially, so once the limit has been reached, the user is unable to load another key definition. The terminal emulator does not inform the user when the buffer limit is reached. In addition, due to the fact that these keys are saved in the Set-Up file, the 256-byte limit exists from one session to the next until the buffer is cleared.

**Full Modem Control**

The VAXmate VT220 terminal emulator does not support full modem control.

The VAXmate VT220 does not conform to DECSTD052. The MS-Windows operating environment does not support preemptive scheduling; in other words, the precise timings required for full modem control cannot be guaranteed.

As an alternative, full modem control can be used in SETHOST. This terminal emulator will pass DBP's Telecom Approvals Authority.

**MS-Windows**

**Data Exchange**

**Script/Dialog Clipboard Problem**

When in a dialog box, the Tab key moves the cursor to the next field and, if that field contains text, the text is highlighted. The Shift/Tab keys move the cursor to the previous box. You can delete highlighted text to a buffer using the period (Del) key on the numeric keypad. You can recover text from that buffer using the 0 (Ins) key on the numeric keypad. However, if the delete operation takes place directly after a Shift/Tab, Tab movement, the text does not go into the buffer. An insert (Keypad 0) after that point copies over the previous delete operation rather than the current delete operation.
Screen Exchange Error

The Alt/Prt Sc key sequence does not perform a screen exchange from a large C- application and, if the function is invoked, the default drive is changed in the MS-DOS Executive window to the system drive from which MS-Windows was started. This is a particular problem when the system drive is read-only.

Desktop Applications

Changing Time in CALENDAR.EXE

If you run Calendar and select the Day Settings command from the Options menu, the Starting Time cannot be changed. If you enter “9:00,” Calendar displays the message “Time should look like 3:29 pm,” even though it does not accept any time like that. You can make Calendar accept a new value by not entering the “am” or “pm,” causing Calendar to default to “am.”

CALENDAR.EXE and 24-Hour Time

If you run Calendar, select the Day Settings command from the Options menu, and then select 24 for the Hour Format, you cannot specify a number in the Starting Time larger than 12:00.

Deleting a Current File When Running Calendar and Cardfile

If, while running Calendar or Cardfile, a file running in MS-Windows and is deleted in the MS Executive Window, and then the user tries to Save it, the message “Change Disk-Insert (filename) disk in Drive A” is displayed and the user cannot cancel out of the box, cannot save the file, and must reboot to continue.

This occurs because Calendar and Cardfile use temporary files to keep changes made by the user. When the user selects Save, the original file is updated. If the original file is deleted, there are unexpected results.

Lowercase AM and PM in CONTROL.EXE

If you run the Control Panel and select the Country Settings command from the Preferences menu, do not enter a lowercase “am” or “pm” in the time format.

Modal Dialog Boxes

MS-Windows displays a modal dialog box when you are required to take some action, and MS-Windows will not continue until you do so. Because of this single-task nature and use of modal dialog boxes, on-line help is not offered with MS-Windows.
Text and Graphics Alignment Problem
Because different output devices have different resolutions, text and graphics that appear aligned on the display may not be aligned when printed. This can be compounded by printers with device fonts because these fonts are represented by other fonts on the display.

Most of the Cardfile information is text rather than graphics. Cardfile is set up to handle text as a series of character cells rather than one large bitmap.

Notepad Save Error
If the Save command in Notepad fails for any reason, try the Save As command, using the same file name. When Notepad goes to save the current edited file, it performs a Reopen. If the current file was previously opened under the VAX/VMS operating system, the Reopen always returns an error.

Notepad and CR,LF,CR
Notepad assumes that each line in a data file is terminated by a carriage return/linefeed/carriage return. If the file was not created with Notepad or most recently edited by it, this may not be the case. If the carriage return/linefeed/carriage return does not exist, the first character of the subsequent line may be lost.

Display
MCGA Monitors and Umlauts
On an MCGA monitor, an umlaut over an “i” or “I” is displayed as a line rather than two dots.

No Support of Newest ISO Font Set
Recently, the ISO character font was updated, adding the following:

• The divide sign at location D7h
• The multiplication sign at location F7h

These characters are missing in MS-Windows Version 2.0. A block character is generated instead of the multiplication or divide sign.

Cursor Type
The DIGITAL adaptation of MS-Windows emulates the MS-DOS cursor type and not the IBM DOS cursor type. The MS-DOS cursor type is a block cursor with a start scan line of zero (0) and an end scan line of seven (7).
Mouseless Version of MS-Windows Displays Mouse Cursor

If you run a mouseless version of MS-Windows, and a system error message box is displayed, a mouse cursor may appear in the center of the display box.

 SUBST of Drive B

If you use the SUBST command on drive B before you run MS-Windows, the substitution is not carried into MS-Windows. The drive B icon is not displayed in the MS-DOS Executive window and you cannot access it.

Size and Scale Problems

MS-Windows uses an internal “font mapper” to choose a font for display or printing. There are two types of fonts, those that are resident in the device or its driver (device fonts), and those that are maintained by MS-Windows itself (GDI fonts).

When an application asks for text to be printed, a font mapper is employed to determine the best match for the request. First, the device is queried for its best device font match given the characteristics of the requested font, such as character set, height, width, weight, and so on. The driver chooses its best match and passes the font back to MS-Windows. MS-Windows then compares the selected device font with all loaded GDI fonts. The resulting best match is the font that gets printed.

Because printer drivers vary with the display driver, the best font for one device may not be the best font for another. Users may complain that the resultant fonts are drastically different from those requested. Font families may change as well as size, weight, and so on.

One item causing confusion is the Size menu in MS-Paint. It does not list point sizes. It lists the height of the character in device units. Therefore, the same font may look half the size on a 400-line video than it does on a 200-line video.

Bad Font Character

There is a problem when ALT 158 is displayed. The discrepancy between Pts and Pt is a difference between MS-Windows STD font and DOS. MS-Windows should be Pt, although it is not. The MS-Windows ISO font does not contain this character and Pt (or Pts) will be mapped to the character “P” when remapping from the STD character set to the ISO character set.
Working with Standard Applications
A standard application is an application (with a .EXE, .BAT, or .COM extension) that can be used with MS-Windows, even though it was not designed specifically to do so. (MS-Windows applications such as Notepad and Clock are specifically designed to be used with MS-Windows.)

Batch File and Program Information Files
If you run a batch file (an application with a .BAT extension) that redirects input and output, you must set the Directly Modifies Screen box in the PIF file for that batch file, and you must run the batch file from the MS-DOS Executive window. For more information on changing PIF files, see Chapter 10 of the *Microsoft Windows User's Guide*.

**NOTE**
You should not run a batch file from a COMMAND.COM window if the file includes redirected I/O or piping.

File and Disk
Protected Files
If a file has the System and/or Hidden attribute set, you cannot delete it using the MS-DOS DEL command. However, you can delete the file using the MS-Windows DELETE option under the MS-DOS Executive File menu.

COMMAND.COM and the MS-DOS Executive are not consistent in the way they determine whether a file can be deleted. The above situation can occur only if the user has removed the read-only attribute of the file. When the system is placed on a disk by either SYS or the MS-DOS Executive, both IO.SYS and MSDOS.SYS have attributes of System, Hidden and Read-only. As long as the read-only attribute is set, the file cannot be deleted using DOS or MS-Windows.

Notepad and File Handling
Notepad has known problems with its file handling. If the current file is saved and an attempt is made to open a second large file, a problem may occur. If the second file cannot be read because of its size, Notepad does not return to the previous file correctly. If the user should do more work on the first file and save it, Notepad may overwrite the second file, even though it was never read successfully.
SUBST and Phantom Drives
There is a problem with IO.SYS and MSDOS.SYS and their use of a phantom drive. The problem is exhibited under the following conditions:

1. Start MS-Windows.
2. Move to a directory with COMMAND.COM in it.
3. Start COMMAND.COM.
4. Enter the following with no diskette in drive A:
   
   > SUBST B: A: \n
5. Perform a directory of drive B:
   
   > DIR B:
   
   Although you get a series of error messages, they are appropriate and the system recovers.

6. Enter the following to disable drive B:
   
   > SUBST B: /D

7. Perform a directory of drive B with or without a diskette in drive A. The result is a series of appropriate error messages and again the system recovers.

8. Enter the following to exit COMMAND.COM:
   
   > EXIT

9. Close the COMMAND application and bring up the MS-DOS Executive window.

   The result is that the drive B icon is still be displayed. If you click on the icon, a series of messages indicate that the drive is bad.

   If a similar operation is performed in MSDOS, an error message is displayed indicating that drive B is a bad unit. If you persist and tell DOS to ignore the problems, the bad unit B will eventually respond with the desired directory and return to handling the missing diskette in the normal “Insert a disk into drive A:” manner for all subsequent accesses.
Formatting a Data Disk
If you use the Format Data Disk command in the Special menu of the MS-DOS Executive window to format a data disk, there are no prompts to insert a blank diskette. If the diskette in the drive is not the diskette to be formatted (and it is not write protected), you could lose the data on the diskette.

Updating Directories in Multiple Windows
If you are displaying the same directory in multiple windows, only the directory listing in the active window is updated when you create, rename, delete, or copy a file. To update the listing in an inactive window, move the mouse to the inactive window and click on the highlighted drive icon.

Renaming a File
If you select the Rename command in the File menu of the MS-DOS Executive window and the operation fails, no error message is displayed. This occurs when you attempt to rename a directory or leave the "To:" box in the dialog box blank.

MS-DOS Executive Window Make System Disk Command
The Make System Disk command in the Special menu of the MS-DOS Executive window uses only the current drive as the source for system files. If it does not find the system files on the current drive, the following message is displayed:

Cannot find system files on current drive

File Name Limitations
MS-DOS for the VAXmate limits file names to 7-bit ASCII characters. Technically, 8-bit characters in a file name are invalid. If you use 8-bit characters, various problems occur because MS-Windows "translates" characters when switching between the ISO character set (Class A applications) and the STD or IBM character set (Class B and C applications).

The following problems could occur:

• Using COMMAND.COM, files could be created with special characters in their names. If the only difference in two file names is the special character, the files will appear identical using the MS-DOS Executive.

• A special character in the file name could prevent the file from being accessed by MS-DOS Executive window commands, such as DELETE, RENAME, and so on.
COMMAND.COM and Class C+ Applications
A Class C+ application, run from COMMAND.COM, does not run as a true C+ application. That is, you cannot move in and out of the application by pressing the Alt/Tab keys.

Copying Files
If you select more than one file from a given subdirectory and use the Copy command from the File menu in the MS-DOS Executive window to copy those files to a single file, the following error message is displayed:

Cannot copy multiple files to a single destination

However, if you select a directory or subdirectory as the source for the copy procedure and a single file as the destination, the procedure appears to work. The name of each of the files in the source directory is displayed in the Copy dialog indicating it was read. Unfortunately, only the last file of the set is present after the procedure is completed.

Drive Letter Fails in COMMAND.COM
If you type a new, valid drive letter while running COMMAND.COM in an active window, no change occurs. If you type a new, valid drive letter a second time, the change occurs.

Keyboard
In order for the LK250 keyboard to work correctly on an IBM XT, you must press the Alt/F17 combination while in DOS, then start MS-Windows.

When the LK250 keyboard is used on an IBM PC or XT, the DCONTROL utility is unable to detect the proper keyboard. Therefore, the Autorepeat and Keyclick Volume options are not grayed out on the screen.

Illogical Keyboard Messages
The following keyboard operations produce an illogical set of messages:

- Ensure that the NumLock LED is on
- Press and hold down the left Shift key
- Press and release the “1” key on the numeric keypad
- Release the left shift key
MS-Windows transmits the following keyboard messages:

<table>
<thead>
<tr>
<th>Message Type</th>
<th>Scan Code (hex)</th>
<th>Prev Key State</th>
<th>Virtual Key State</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>WM_KEYDOWN</td>
<td>2a</td>
<td>Up</td>
<td>VK_SHIFT</td>
<td>Left shift</td>
</tr>
<tr>
<td>* WM_KEYUP</td>
<td>36</td>
<td>Down</td>
<td>VK_SHIFT</td>
<td>Illogical msg. (right shift)</td>
</tr>
<tr>
<td>WM_KEYDOWN</td>
<td>4f</td>
<td>Up</td>
<td>VK_END</td>
<td>Keypad “1”</td>
</tr>
<tr>
<td>* WM_KEYDOWN</td>
<td>36</td>
<td>Up</td>
<td>VK_SHIFT</td>
<td>Illogical msg. (right shift)</td>
</tr>
<tr>
<td>* WM_KEYUP</td>
<td>36</td>
<td>Down</td>
<td>VK_SHIFT</td>
<td>Illogical msg. (right shift)</td>
</tr>
<tr>
<td>WM_KEYUP</td>
<td>4f</td>
<td>Down</td>
<td>VK_END</td>
<td>Keypad “1”</td>
</tr>
<tr>
<td>* WM_KEYDOWN</td>
<td>36</td>
<td>Up</td>
<td>VK_SHIFT</td>
<td>Illogical msg. (right shift)</td>
</tr>
<tr>
<td>WM_KEYUP</td>
<td>2a</td>
<td>Down</td>
<td>VK_SHIFT</td>
<td>Left shift</td>
</tr>
</tbody>
</table>

If you press the right Shift key instead of the left Shift key, the number of messages is the same. However, the two messages with a scan code of 2AH are changed to 36H.

The keys on the numeric keypad that exhibit this behavior are zero (0) through nine (9), minus sign (VK_SUBTRACT), plus sign (VK_ADD), and the period (.), which can be either VK_DECIMAL or VK_DELETE.

**MS-Paint**

**Memory Requirements**

MS-Paint cannot properly determine the amount of memory it requires. For example, if you load three or four instances of MS-Paint, they will interfere with each other. The background may be corrupted. The system could stop. The occurrence of this problem depends on the amount of available memory in the user's machine.

**Printing an MS-Paint Screen**

If you use MS-Paint to draw a picture on the screen or for a specific type printer, the picture cannot be printed on another type printer. The resolution of the new printer must be the same as the resolution in effect when the picture was drawn.
When using MS-Paint, record the name of the output device for which a file or picture was intended.

**Dotted Line Selection**
When the dotted line width is selected in the Line Widths command of the Palette menu, no line can be drawn using any “snap draw” icons, such as line, circle, arc, and so on.

**MS-Write**

**Printing Text and Graphics**
MS-Write cannot print a file containing text and graphics on a text-only (line) printer. However, the Print menu item is not disabled, allowing the user to print the text portion of the document. Similarly, MS-Write allows the user to resize the picture. If you select the Size Picture command in the Edit menu, the system changes to DOS or stops.

**Invalid Font List**
WRITE.EXE produces an invalid list of printer fonts when the printer is changed and the new file is saved. The list of fonts may be cumulative and include fonts from each printer as that printer is used in a subsequent MS-Write document. The fonts are tied to the user, not to the documents.

**Incorrect Fonts**
If you specify different size fonts of the same typeface in MS-Write, you may not see the results you want. For example, if you request an 8-point font, a 10-point font, and a 12-point font, all your output may be done with the 8-point font. No changes will be made for the size of a font in the same typeface.

**MS-Write and Text-Only Files**
MS-Write does not produce optional “text-only” output. Its normal data files do not contain lines terminated with carriage return/linefeed pairs. It is, therefore, difficult to read MS-Write files with other editors in other operating systems.

You can read the file with Notepad and reformat it manually. Similarly, you can copy the file to the Clipboard and then paste it to another application.
PIF Files

The PIF files included in the Digital adaptation of MS-Windows Version 2.0 are supplied by Microsoft.

PIF File and RUN MODULE Must Have Same Name

To run a standard application in MS-Windows, a PIF file must exist for that application. When invoking such an application from the MS-DOS Executive window, it is possible to double-click on the PIF file rather than the executable file (.EXE, .COM, or .BAT). The advantage of double-clicking on the PIF file is that you can maintain multiple PIF files for the same application, thereby allowing you different ways of running a single application.

The multiple PIF advantage is lost when an application is run from COMMAND.COM or from a batch file within MS-Windows, because PIF files cannot be run directly from these environments.

Printing

Printing a Text File from the MS-DOS Executive Window

Printing a text file using the MS-DOS Executive may take more time than expected. This occurs because printing does not start until the complete file has been sent to the Spooler. Therefore, the length of the delay depends on the complexity and length of the file you are printing.

Printing From a Class A Application Using GDI

When printing from a Class A MS-Windows application, the program must create a printer DC. Any necessary objects must be created and selected. Normally in a DC, the selected objects, in other words Pen, Brush, Font, and so on, remain selected until a replacement object is selected. This is not the case when the DC is for a printer. In order to print from GDI, the program must signal the first of the printout (STARTDOC) and the end (ENDDOC) and between pages (NEWFRAME). NEWFRAME signals the end of the GDI page and the beginning of the next. Apparently, NEWFRAME causes the default brush to be reinstated. Thus, if you wish to print with the same brush of your choice on two pages, you must select it, print the first, issue the NEWFRAME to end the page, then select the brush again and draw the second page.
Printer Fonts with Pagemaker and MS-Write
The font information recorded in a user's WIN.INI file by Pagemaker and MS-Write may conflict with each other.

LA50 Printer and Compressed Mode
The LA50 printer driver cannot print in compressed mode.

Printing MS-Windows Screens
You must load and run the GRAPHICS command before you try to print an MS-Windows screen. For more information, see the MS-DOS Reference Manual.

LA210 Printer and MS-Paint
When printing U.S. letters, DIN A4, or Euro Fanfold .MSP files (from MS-Paint), the LA210 printer does not print the rightmost column of pixels.

Text-Only Printer Driver
The Digital Generic Text-Only line printer driver, LINE.DRV, tries to print graphics, although it is unable to do so. This occurs when you try to use MS-Write to print a document with text and graphics. The first page may be printed before the driver displays a message indicating it cannot print the document. LINE.DRV should print only the graphics portion of the document as the Microsoft printer driver TTY.DRV does.

LINE.DRV and Paper Width and Length
The line printer driver, LINE.DRV, does not check the paper width and length fields for valid numbers. There are also roundoff errors in the English-to-metric unit conversion.

LN03 Plus Printer Driver
The LN03 Plus printer driver, LN03PLUS.DRV, does not work correctly with Pagemaker. It does not print GDI fonts correctly in some documents. If this problem occurs, use nondevice fonts.

The LN03 Plus printer driver, LN03PLUS.DRV cannot draw on the bottom of a page. You actually get two pages of output. The second page contains approximately 15 scan lines worth of pixel data that should have been on the previous page.
Running Special Applications

Special applications, sometimes called "terminate and stay resident" programs, remain in memory after you exit them.

You must load special applications before you start MS-Windows.

You run special applications from MS DOS outside MS-Windows. You can also run special applications while using standard applications that both:

• Do not run in a window
• Have Directly Modifies Memory set in the PIFs

You cannot run special applications from COMMAND.COM in MS-Windows.

NOTE
The PIF for a special application should have the Directly Modifies Memory option enabled. If you then try to run a special application, a system warning displays. Select CANCEL. If you select OK, the special application can cause system problems.

Some special applications prevent you from switching back to MS-Windows. To return to MS-Windows, enter EXIT and press the Return key.

Using MS-DOS Commands and Programs
MS DOS commands are divided into three groups:

• Commands you must use outside of MS-Windows
• Commands you run from MS-Windows with COMMAND.COM
• Commands you run from the MS-DOS Executive window

Those commands that run outside MS-Windows can run from the MS-DOS operating system prompt. Or, you can put these commands in your AUTOEXEC.BAT file, which runs automatically before MS-Windows starts. For more information on MS-DOS commands and programs, see the MS-DOS Reference Guide or refer to the DOS reference manual that comes with your DOS software.

You must run the following commands outside MS-Windows (an asterisk indicates commands that have an MS-Windows equivalent):

APPEND  ASSIGN  CHKDSK
You can run the following MS-DOS commands from the Command window in MS-Windows (an asterisk indicates commands that have an MS-Windows equivalent):

- BREAK
- COPY*
- DIR*
- EXIT
- IF
- PATH
- REM
- SET
- TYPE
- VOL*

You can run the following MS-DOS commands from the MS-DOS Executive window (an asterisk indicates commands that have an MS-Windows equivalent):

- ATTRIB
- DEBUG
- EXE2BIN
- FIND
- LINK
- RESTORE

CreateCompatibleDC(hDC)

CreateCompatibleDC(hDC) creates a memory display context that is compatible with the DEVICE specified by hDC (and automatically selects a monochrome stock bitmap for it). The memory DC created is compatible with the device only, not with any other characteristics of the DC passed as an argument. Any attributes must be specifically set by the application.
The CreateCompatibleDC function does not copy mapping mode, windows extents and origins, or viewport extents and origins from the old DC into the newly created compatible DC.

Setup Utility
If the PCSA INSTALL utility is used to install PCSA Version 2.1, the MS-Windows Setup utility may not run. Setup requires 512 Kbytes of available memory. INSTALL is not deallocating memory correctly. The only option is to reboot the workstation and run the Setup utility. Depending on their sizes, other terminate and stay resident programs may cause a similar problem.

Other
Starting SLAPJR with the Run Command
You cannot start SLAPJR using the Run command of the MS-DOS Executive window. You must go to the directory where SLAPJR is located and select the file to start it.

Starting MS-Windows and the DIGITAL Logo
If you start MS-Windows by entering “WIN” plus an argument, the DIGITAL logo is not displayed.

Interrupt 10H Function 19 Subfunctions Disabled
The Int 10h, function 19, subfunctions 0, 1, 2, and 3 have been disabled. Any program accessing these features will be returned to with no registers changed.

The COPY command and Device Names
When copying to a logical device, do not include the conventional colon (:) following the device name.

Repeating Key Allowed to Change Focus
When two or more copies of the same MS-Windows application program are loaded, it is possible to change the input focus of a repeating key. To create the condition, two or more copies of the applications program must have autorepeat enabled.

Select the first copy by moving the cursor to its window and pressing the left mouse button, which gives the first copy the input focus. Press and hold the A key. After the required delay, the MS-Windows displays multiple instances of the A key. While the key is automatically repeating, move the mouse cursor to another copy of the application and press the left mouse button. This gives the second copy the input focus. When the
focus shifts to the second copy, the repeating key follows the input focus, and the second copy displays the repeating key.

If the program monitors only the translated (WM_CHAR or WM_SYSCHAR) messages, the problem is not apparent. However, if the program monitors the KEYDOWN and KEYUP messages, there are at least two problems:

- The first copy of the program does not receive a KEYUP message.
- The second copy of the program receives a KEYDOWN message with a previous state of key down. The second copy should have received a KEYDOWN message with a previous state of key up.

PIF Program Parameters Incompatible with DOS

Program parameters let you pass information to an application when you start it. In the Program Parameters text box, you can type either of the following:

- Question mark
  
  If you type a question mark, MS-Windows prompts you with a dialog box for application parameters when you start the application. You can enter up to 126 characters in the dialog box. If you enter more than 126 characters, MS-Windows does not beep to indicate an error. However, MS-Windows interprets no more than 126 characters.

- Specific program parameters
  
  If you type specific parameters, those application parameter values are used every time the application is started. You can enter up to 37 characters in the Program Parameters text box.

  You should not redirect input and output or use piping.

  If your application requires no parameters, or if you are uncertain, leave this option blank.

Incompatible C Libraries

Calloc(0,0) returns:

- A non-NULL pointer when resolved by linking with "slibc"
- A NULL pointer when resolved by linking with "slibw"

In other words, slibw{calloc(0,0)} != slibc{calloc(0,0)}. The same inconsistency may exist for "malloc" and "realloc" as well as for other libraries.
Multiple Class B or C Applications Stop MS-Windows
If you run multiple Class B and C programs, MS-Windows can stop. This occurs because of memory requirement miscalculations.

Testing Keyclick Volume
You cannot test keyclick volume until you exit DCONTROL.

Invalid Compose Sequences
Function keys used as accelerators are not valid in a compose sequence and should be sent to MS-Windows as WM_DEADCHAR.

CloseComm Returns Error Message
The Microsoft serial communications driver, CloseComm, returns the following output:

- 8000h  Invalid device
-           Output queue timeout
- 0     All other instances

The CloseComm terminate routine will not close the communications port until either the output queue is flushed or until it fails to transmit any characters over a 1-second period. If the latter occurs, an output queue timeout error code (-2) is returned.

EPSONMX.DRV and Linefeed Character
The LA210Graftrax printer driver (EPSONMX.DRV) does not respond to linefeed characters when printing from the MS-DOS Executive window.

Renaming VAXmate Server Volume Name
You can rename a VAXmate server volume name. For example:

1. Set the volume name to all blanks.
2. Delete the volume name.
3. Set the volume name to its new name.

Cancel MS-Windows Using Ctrl/C
If you start MS-Windows and press Ctrl/C to cancel out of MS-Windows, the video is left in a graphics mode.
Drive Icons Not Connected
In the MS-DOS Executive window, the drive C, E, and F icons are displayed even if you have made no connection to them. If you click on one of these icons, the system error dialog box appears with the error message “Cannot read from drive n” as though a connection had been lost.

File Viewing
When run, certain DOS utilities may cause the type of selected file viewing to change in the MS-DOS Executive window. For example, if you select the By Kind command in the View menu, the list remains sorted by kind or, in some cases, reverts to just an alphabetized listing. The DECKEYB and GRAPHICS commands reset file viewing. The COMMAND and TREE commands do not reset file viewing.

SYS Command
The VAXmate SYS command, both in MS-DOS and in MS-Windows, does not copy the boot sector and does not follow the recommendations of Microsoft. System administrators with both PC-DOS and MS-DOS systems must consider this because swapping media can be a problem.
READER'S COMMENTS

Your comments and suggestions help us to improve the quality of our publications.

For which tasks did you use this manual? (Circle your responses.)

(a) Installation (b) Operation/use (c) Maintenance (d) Programming (e) Training (f) Other (Please specify.)

Did the manual meet your needs? Yes □ No □ Why? ________________________________

Please rate the manual in the following categories. (Circle your responses.)

<table>
<thead>
<tr>
<th>Category</th>
<th>Excellent</th>
<th>Good</th>
<th>Fair</th>
<th>Poor</th>
<th>Unacceptable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accuracy (product works as described)</td>
<td>5</td>
<td>4</td>
<td>3</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>Clarity (easy to understand)</td>
<td>5</td>
<td>4</td>
<td>3</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>Completeness (enough information)</td>
<td>5</td>
<td>4</td>
<td>3</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>Organization (structure of subject matter)</td>
<td>5</td>
<td>4</td>
<td>3</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>Table of Contents, Index (ability to find topic)</td>
<td>5</td>
<td>4</td>
<td>3</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>Illustrations, examples (useful)</td>
<td>5</td>
<td>4</td>
<td>3</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>Overall ease of use</td>
<td>5</td>
<td>4</td>
<td>3</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>Page Layout (easy to find information)</td>
<td>5</td>
<td>4</td>
<td>3</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>Print Quality (easy to read)</td>
<td>5</td>
<td>4</td>
<td>3</td>
<td>2</td>
<td>1</td>
</tr>
</tbody>
</table>

What things did you like most about this manual? __________________________________________

What things did you like least about this manual? _________________________________________

Please list and describe any errors you found in the manual.

<table>
<thead>
<tr>
<th>Page</th>
<th>Description/Location of Error</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Additional comments or suggestions for improving this manual: ________________________________

Name ___________________________ Job Title ___________________________

Street ___________________________ Company ___________________________

City ___________________________ Department ___________________________

State/Country ___________________ Telephone Number ___________________

Postal (ZIP) Code __________________ Date ___________________________